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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Why should I create my app using HP
Anywhere IDE (Eclipse)?

HP Anywhere provides an Eclipse-based IDE that enables you to create, build, run, and debug your
own apps.

This IDE provides a complete development environment that covers the entire lifecycle of your app
and enables you to create, debug, maintain your app projects. HP Anywhere IDE includes:

l A wizard for creating app projects

l A built-in simulator that you can use to run and debug your apps in any form factor (desktop,
tablet, or smartphone) or screen resolution

l Deployment capabilities that publish your apps for you, including hot deployment for locally
deployed apps and automatic minification so that your apps are always production-ready.

l A complete, pre-configured, database-free, and debug-ready HP Anywhere server that is
customized and optimized for the development environment.
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How to build and run your app using HP
Anywhere IDE—End-to-end walkthrough

The following steps describe how to build and run an app using HP Anywhere IDE.

1. Make sure that HP Anywhere IDE is installed on your computer.

2. Use the HP Anywhere App Project wizard to create the package and files for your app project.
This provides you with a ready-to-run app that includes all of the necessary files, classes, and
methods. You can select from the any of the available templates to get you started. For details,
see "How do I create an app project in HP Anywhere IDE?" on the facing page, "Appendix 1:
App Project Folder Structure" on page 39, and "Appendix 2: Template Descriptions" on page
42.

3. Add your code.

4. Define your app configuration settings. For details, see "How do I define the configuration for
my app?" on page 16.

5. Run and debug your app by running it on the built-in HP Anywhere local server or a remote
server. For details, see "How do I runmy app on the local server?" on page 18 and "How do I
debugmy app code?" on page 32.

6. When your app is ready, you can give the app content pack .zip file to the HP Anywhere
administrator so that he or she can deploy it on the HP Anywhere server and enable it in the
catalog. This .zip file has the following naming convention: <App name>-cp.zip, and is
located in the <App project>\target folder.
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How do I create an app project in HP
Anywhere IDE?

You use the HP Anywhere App project wizard to create a new HP Anywhere IDE project containing
the files and classes for your app.

When you create an app using HP Anywhere IDE, an app content pack is generated as a .zip file in
the <App project>\target folder.

This .zip file has the following naming convention: <App name>-cp.zip. You need to give this to
the HP Anywhere administrator when the app is ready so that he or she can deploy it on the HP
Anywhere server and enable it in the catalog.

Note: If you connect to the Internet via a proxy, youmay need to configure aMaven proxy the
first time you create an app. For details, see " How do I set up aMaven proxy?" on page 47.

To create an HP Anywhere app project in HP Anywhere IDE:

1. Select File > New > HP Anywhere App Project. The HP Anywhere App Project wizard
opens.
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2. In the Project Template area, select the type of template from the Type drop-down list. Each of
the templates generates a starter project to which you can add your own code. Several types
are available:

n Blank project. AnHP Anywhere starter project that contains the project folder structure
without application content.

n Hello World projects. HP Anywhere starter projects that generate apps using the
specified framework (such as native, Enyo, JQM, Sencha, or AngularJS). These projects
are targeted for use on tablets and smartphones.

n My Report projects. HP Anywhere starter projects that generate apps that can display a
list of reports. These projects use the specified framework (such as native, Enyo, JQM,
Sencha, or AngularJS). These projects are targeted for use on tablets and smartphones.

TheDescription box provides details for the selected template.

For a detailed description of each of these templates, see "Appendix 2: Template Descriptions"
on page 42.

3. In the Form Factor area, select one or more form factors. The following form factors are
available:

n Desktop

n Tablet

n Smartphone

Note: After you create a project, you canmanually add form factors that you did not
select while creating the project. For details, see "How do I add or remove form factors in
my app project?" on page 14.

4. In the App Preferences area, select theAllow an app to run in offline mode check box if
you plan to enable your app to work without an Internet connection.

Note: Selecting this check box by itself does not enable offline support. Youmust also
add code to support offlinemode. For details see the sample app cookbooks on the
Developer Zone.

5. In the Project Details area, define the following using standardMaven naming conventions:

n App Name. The name of the app, for example, HelloWorld. (Use only alphanumeric
characters. Special characters and spaces are not allowed.)

n Group ID. A unique, reverse domain name, for example, com.mycompany.mygroupname.
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The group ID is used in the generated POM.XML project file.

n Source package. A valid Java package name, for example, com.my.mypackage. The
package name represents the folder structure that is generated in the workspace.

n App version. The version string for your app, for example, 1.0.0.

n App icon. A PNG file that represents your app. The icon is displayed in the app on theMy
Apps page in HP Anywhere.

6. Click Finish. HP Anywhere generates the app project. While the project is being created, you
can view the log in the Console tab. (The first time you create a project, this may take some
time.) After the project is created, you can:

n View the project folder structure. For details, see "Appendix 1: App Project Folder Structure"
on page 39

n Add code to the app project.

n Run the app. For details, see "How do I runmy app on the local server?" on page 18.
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How do I add a third-party library to my app?
If you add a third-party dependency to the pom.xml file, youmust also add it to the HP Anywhere
project, as an Eclipse dependency. This enables code compilation in the IDE.

1. Open a command line (CLI).

2. Change the directory to the root directory of your app.

3. Run the following command:%btoa_home%\apache-maven-3.0.4\bin\mvn eclipse:eclipse

4. In the project tree, right-click the app node and select Refresh to refresh the app project in HP
Anywhere IDE.

Supported Third-Party Libraries
Your app can use the following third-parties libraries:

l Spring (version 3.0.5)

l Jackson (version 1.5.5)

l Jersey (version 1.5)

l JSR 311-api (version 1.1.1)

l ApacheWink Client (version 1.1.1)

l Hibernate Validator (version 4.2.0)

l CGLIB (version 2.2)

l SLF4J LOG4J (version 12 1.5.11)
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How do I add or remove form factors in my
app project?

When you create your app project, you specify the form factors (desktop/tablet/smartphone) on
which your app can run.

If you do not select all form factors when you create the project, you can add them later by adding
folders for the required form factors to your app's package. Similarly, you can remove form factors
from your app by removing the relevant project folders.

To add form factors for your app:

1. In the HP Anywhere IDE Package Explorer, expand themain app folder.

2. Copy/paste the folders for an existing form factor (desktop, tablet, or smartphone) in each of
the following locations:

l src > webapp > app

l src > webapp > css

l src > webapp > images

3. Rename each of the new folders to the required form factor type (desktop, tablet, or
smartphone).

4. Add your client code to the new form factor folders.

5. In src/resources > descriptor.xml, create a section for each form factor by copying the
following section and replacing the <existing form factor type> with the <new form factor
type>. For example, copy the following section and replaceDESKTOP withSMARTPHONE.
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To remove form factors:

In the HP Anywhere IDE Package Explorer:

1. Expand themain app folder.

2. Remove the relevant section from src/resources > descriptor.xml. For example, to remove
the desktop form factor, delete the following:

3. (Optional) In each of the following locations, delete the folders for each form factor (desktop,
tablet, or smartphone) that you want to remove:

l src > webapp > app

l src > webapp > css

l src > webapp > images
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How do I define the configuration for my
app?

After you create your app, you can configure its settings, which are located in the src/resources
folder.

User Settings
You define these settings for your app's users.

To modify the user settings:

1. In the Package Explorer, navigate to: /<app main node>/src/resources/<app name>-user-
settings.xml and double-click the file.

2. In the app name>-user-settings.xml tab, select theDesign tab.

3. Right-click context and select Add Child > setting.

4. Expand the setting node you just added and enter values for the following:
a. name. The ID for this setting.

b. namekey. A setting used for localization.

c. integer. The default setting type. You canmodify this by right-clicking and selecting
Replace With > <value type>.
Possible values:
boolean
enumeration
float
password
string
xml

Administrator Settings
You define these settings for your app's administrators.

To modify administrator settings:

1. In the Package Explorer, navigate to: /<app main node>/src/resources/<app name>-
admin-settings.xml and double-click the file.

2. In the app name>-admin-settings.xml tab, select theDesign tab.

3. Right-click context and select Add Child > setting.
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4. Expand the setting node you just added and enter values for the following:
a. name. The ID for this setting.

b. settingType. Make sure that global is selected.

c. displayInUI. Specifies whether the app is visible in the HP Anywhere Administrator
Console.
Possible values:
true
false

d. sectionKey. The name of the group area that is displayed in the Settings tab of the
Administrator Console (for the app that is selected in the List of Categories column).

e. integer. The default setting type. You canmodify this by right-clicking and selecting
Replace With > <value type>.
Possible values:
boolean
enumeration
float
password
string
xml

Data Source Settings
You define the settings that enable the app to communicate with the backend server.

1. In the Package Explorer, navigate to: /<app main node>/src/resources/<app name>-ds-
provider.xml and double-click the file.

2. In the app name>-admin-settings.xml tab, select theSource tab.

3. Modify the configuration as needed.

HP AnywhereIDE (10.10) Page 17 of 51

Developer Guide (Eclipse)
How do I define the configuration for my app?



How do I run and view my app?
You can run your app in debug mode or run mode on either a local or remote server. HP
Anywhere IDE comes with a built-in local server that enables you to take advantage of hot
deployment.

When you run your app, HP Anywhere performs the following:

1. Starts the HP Anywhere server if it is not already up and running.

2. Deploys your app on the specified server, if needed.

3. Creates two versions of your app—one for development use and one that is minified and ready
for production. You can toggle between the two in the output.

4. Opens HP Anywhere Simulator in a Chrome browser.

When you run your app project for the first time, HP Anywhere IDE compiles the project files, zips
them, and deploys them on the HP Anywhere server.

Later, when youmodify your project files and run your app on the local server, HP Anywhere
provides hot deployment of your Java code, so you canmodify your app in realtime without
restarting the server.

You can view and debug your app on the built-in simulator or on your ownmobile device (if the
device is in the same LAN and the HP Anywhere client is installed on it). For details, see "How do I
runmy app on a remote server?" on page 22.

Note: For details on running legacy apps that were created using an earlier version of HP
Anywhere, see "How do I run an app that was created using an earlier version of HP Anywhere
IDE?" on page 49.

Tip: To clean the database and remove all of your deployed apps and their configuration files,

click Remove All Deployed Apps .

(Youmay need tomanually remove the linked projects from Eclipse (in the Servers tab).)

How do I run my app on the local server?
You can run your app on the built-in local server. This enables you to take advantage of hot
deployment.

To run your app in run mode on the local server:
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1. Prerequisite for Sencha Users (needs to be performed once per computer):

a. Make sure that the Sencha version 2.0.0 Beta 3 forWindows is installed on your computer.

b. Download phantomjs-1.9.1-windows.zip from http://phantomjs.org/.

c. Extract phantomjs.exe from the .zip file and copy it to the Clipboard.

d. Paste (overwrite) phantomjs.exe in the Sencha \bin folder, for example: C:\Program Files
(x86)\SenchaSDKTools-2.0.0-beta3\bin\phantomjs.exe

2. Do one of the following:

n In the project explorer, right-click the HP Anywhere project folder and select Run HP
Anywhere App.

n Click .
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The RunOn Server dialog box opens.

3. Select Local HP Anywhere Server at localhost and click Finish The server starts and runs
your app using the default form factor and resolution. While the app runs, you can view the log
in the Console tab.
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4. When the run finishes, the app opens in a Chrome browser, as shown in the following example.
If your project contains code that supports other form factors and resolutions, you can select
them from the drop-down arrows above the simulated form factor. You can also double-click
the simulated form factor to view more details.

For details on how to switch between the development version and theminified version of the
app, see "How do I minify my app?" on page 34.
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How do I run my app on a remote server?
You can run your app on a remote server. For general details, see "How do I run and view my app?"
on page 18.

To run your app in run mode on a remote server:

1. Prerequisite for Sencha Users (needs to be performed once per computer):

a. Make sure that the Sencha version 2.0.0 Beta 3 forWindows is installed on your computer.

b. Download phantomjs-1.9.1-windows.zip from http://phantomjs.org/.

c. Extract phantomjs.exe from the .zip file and copy it to the Clipboard.

d. Paste (overwrite) phantomjs.exe in the Sencha \bin folder, for example: C:\Program Files
(x86)\SenchaSDKTools-2.0.0-beta3\bin\phantomjs.exe

2. Do one of the following:
n In the project explorer, right-click the HP Anywhere project folder and select Run HP

Anywhere App.

n Click .

n In the package explorer or project explorer, right-click the HP Anywhere project folder and
select Run As > Run On Server.
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The RunOn Server dialog box opens.
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3. SelectManually define a new server. The dialog box enables you to specify a different
server.

n Select Remote HP Anywhere Server.

n In theServer's host name box, specify the remote server's name or IP address.

n (Optional) In theServer name box, modify the server name.

n (Optional) Select theAlways use this server when running this project check box if you
always want to run your app only on this server.
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4. Click Next. The JRE preferences page opens.

Set theHP Server home path to <installation folder>, for example:
C:/HP/HPAnywhere
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5. Click Next. The login details page opens. Modify the default values, as needed.
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6. Click Next. The Add and Remove page opens.

(Optional) You can add or remove projects to run on this server, as needed.

7. Click Finish.The server starts and runs your app on the specified remote server using the
default form factor and resolution. While the app runs, you can view the log in the Console tab.

Note: If Chrome generates a profile-related error message, close themessage and
continue to the next step.
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8. When the run finishes, the app opens in a Chrome browser, as shown in the following example.
If your project contains code that supports other form factors and resolutions, you can select
them from the drop-down arrows above the simulated form factor. You can also double-click
the simulated form factor to view more details.

Note: After you run an app on a remote server, youmay need tomanually enable it in the
catalog.

For details on how to switch between the development version and theminified version of the
app, see "How do I minify my app?" on page 34.
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How do I run my app on a device?
You can run your app from any supported smartphone, tablet, or desktop/laptop computer.

To run your app on a device:

1. For mobile devices, install the HP Anywhere client from Google Play or the Apple App Store.

2. Connect themobile device or your desktop/laptop to the Internet via the same LAN as the HP
Anywhere server.

3. From the device, log onto the HP Anywhere server on which your app is installed.
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How do I view my app on HP Anywhere Simulator?
You can use the HP Anywhere Simulator to view your app in any form factor.

Note: Youmust run the app project at least once before you can open it in the HP Anywhere
Simulator, and the server must already be running.

To view your app project on HP Anywhere Simulator:

1. Do one of the following:
n In the project explorer, right-click the project and select View HP Anywhere App

Simulator.

n Click .
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The app opens in a Chrome browser on the last server on which you ran this project.

Note: The HP Anywhere Simulator bar at the top of the window times out and hides
automatically to enable you to use the full real estate. To restore the bar, click the blue line
under the bar.

2. In the HP Anywhere Simulator bar, click the arrow adjacent to the required form factor and
select the required screen resolution. (Desktop opens in a new tab or window.)

Note: Only the form factors you specified when creating the project are enabled in the HP
Anywhere Simulator bar.

For details on how to switch between the development version and theminified version of the
app, see "How do I minify my app?" on page 34.
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How do I debug my app code?
You can run your app in debugmode.

To debug your app:

1. In Eclipse IDE, right-click the app project folder and select Debug As > Debug On Server.
The DebugOn Server dialog box opens.
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2. Select Local HP Anywhere Server at localhost and click Finish. The server starts and runs
your app on the local server. As the app runs, you can view the log in the Console tab, as
shown in the following example:

3. When the run is complete, the app opens in a Chrome browser. The development tools are
displayed at the bottom of the page.

4. Debug your code:

a. Debug your Java code as you would in Eclipse (using breakpoints, and so on). For
example, see: http://www.eclipse.org/resources/resource.php?id=503

b. Debug your JavaScript client code in the Chrome browser. For example, see:
https://developers.google.com/chrome-developer-tools/docs/javascript-debugging
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How do I minify my app?
Minification is the process of removing all unnecessary characters from source code (such as
white space characters, new line characters, comments, and block delimiters) without changing the
code functionality.

Your HP Anywhere app project files must beminified before going live for production. To ease this
process, HP Anywhere IDE provides an out-of-the-box minificationmechanism that automatically
minifies your app projects for you.

Theminification process is framework-dependent. HP Anywhere comes with automatic
minification support for apps created using the native, Enyo, and jQuery Mobile (JQM) frameworks.
(For Sencha, see note below.) You can also add your ownminification process by editing the
minify.bat file in the root folder of your project.

When HP Anywhere IDE builds an app project, it creates two versions—one for development, and
one that is minified and ready for production. You can switch between these versions at any time by
modifying the appdev flag in the URL, as described below.

To switch between the development version and the minified version of the app:

Set the value of appdev in the URL as follows:

l appdev=true for development mode

l appdev=false for minified mode

Example URL:

http://localhost:8080/simulator/simulator.jsp?user=myusername&password=mypassword&appde
v=true&miniApp=MR&serverHost=localhost:8080

Tip: You can also delete the&appdev=true part to show theminified version.

Notes for Sencha Developers:

1. Youmust replace the phantomjs.exe file in your Sencha /bin folder beforeminifying or
running your app. (This step needs to be performed once per computer):

a. Make sure that the Sencha version 2.0.0 Beta 3 for Windows is installed on your
computer.

b. Download phantomjs-1.9.1-windows.zip from http://phantomjs.org/.

c. Extract phantomjs.exe from the .zip file and copy it to the Clipboard.

d. Paste (overwrite) phantomjs.exe in the Sencha \bin folder, for example: C:\Program
Files (x86)\SenchaSDKTools-2.0.0-beta3\bin\phantomjs.exe
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2. When you build your Sencha-based app project, youmust run theminification process
manually by running the following commands using a command line interface (CLI):

cd <your_Sencha-based_project>/src/webapp

minify sencha
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How do I enable hot deployment and
synchronization when my app changes?

After you run your app at least once on the local server, hot deployment is automatically enabled.
This means that every time you save your project, your static JavaScript and configuration files are
automatically synchronized with the files on your local HP Anywhere server.

If you import an app project that was not created using HP Anywhere IDE, you can instruct HP
Anywhere IDE to synchronize any changes youmake to your app files with the deployed app on the
local server.

This section describes how:

l "To enable/disable automatic hot deployment on your static (JavaScript) files (/src/webapp/):"
below. Applies to files, such as CSS or image files.

l "To perform on-demand hot deployment on your Java code:" on the facing page.

l "To enable/disable synchronization of your app's configuration files (/src/resources):" on page
38. Applies to <app_name>-admin-settings.xml, <app_name>-ds-provider.xml, <app_name>-
user-settings.xml. By default, these files are automatically synchronized.

To enable/disable automatic hot deployment on your static (JavaScript) files
(/src/webapp/):

Note: Automatic hot deployment is enabled by default.

1. Prerequisites:

a. Build your app. For details, see "How do I create an app project in HP Anywhere IDE?" on
page 9.

b. Run your app at least once on the local server. For details, see "How do I runmy app on the
local server?" on page 18.

c. Make sure that the local server is up and running.

2. In the project tree:

a. Right-click the app node and select Properties.

b. In the left pane of the Properties dialog box, select File synchronization.
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c. In the File synchronization pane, select theEnable FileSync builder for project check
box and click OK to enable hot deployment.

Clear theEnable FileSync builder for project check box to disable automatic hot
deployment.

From now on, your changes are saved to the local server whenever you save your app
project.

To perform on-demand hot deployment on your Java code:

1. Prerequisites:

a. Build your app. For details, see "How do I create an app project in HP Anywhere IDE?" on
page 9.

b. Run your app at least once on the local server. For details, see "How do I runmy app on the
local server?" on page 18.

c. Make sure that the local server is up and running.

2. In the project tree, right-click the app node and select Reload HP Anywhere App. The server
reloads the app with themodified Java code.
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Note: If you consistently receive notification that the HP Anywhere server is not started while
trying to reload your app, youmay need to configure the eclipse.ini file, as follows:

1. Close HP Anywhere IDE.

2. Open the <HP Anywhere_installation_folder>\eclipse\eclipse.ini file in a text editor.

3. Add the following line to the end of the file:

-Dhttp.nonProxyHosts=localhost|127.0.0.1

4. Restart HP Anywhere IDE.

To enable/disable synchronization of your app's configuration files (/src/resources):

(Applies to the XML files for admin settings, data source provider, and user settings)

1. In the project tree:

a. Right-click the app node and select Properties.

b. In the left pane of the Properties dialog box, select:

o Configure > AddHP Anywhere Builder to enable synchronization of your app's
configuration files. (Selected by default for all new HP Anywhere app projects)

o Configure > RemoveHP Anywhere Builder to disable automatic synchronization of
your app's configuration files.

2. (Optional) After youmake changes to your code, open the HP Anywhere Console to view the
synchronizationmessage. For example:
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Appendix 1: App Project Folder Structure
Each of the templates provided with HP Anywhere IDE generates an app using a specific
framework, such as Sencha, Enyo, JQM, or a native framework. If you are familiar with these
frameworks, you will seemany similarities to other projects that youmay have already created.

This section provides an overview of the unique files and folders that are generated as part of an HP
Anywhere IDE app project.

By default, each app project has the following package structure:

Every project includes the following folders:

Project name The non-modifiable name of the app project, as defined in the HP Anywhere
app Project wizard.
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src/java The Java code used by the app. Every template has its ownREST
services. The report-specific templates all use the same service to retrieve
data. Java has two classes:one is a Java bean (ReportBean.java), which
retrieves the entity; the other is a Java service (ReportService.java) that
retrieves the report data.

src/resources The server-side configuration files (for example, settings, data source, and
localization files).

l10n. Localization folder that includes *.properties files for each language
in which the app can be displayed.

log.Log files folder that includes log4j.properties and
logging.properties.

descriptor.xml. Specifies all of the form factors (desktop, tablet, and/or
smartphone) that are supported for the app. (You store the actual resource
files under src\webapp\<app/css/images>, described below.)
For details on adding or removing form factors in your project, see "How do
I add or remove form factors in my app project?" on page 14.

<app_name>-admin-settings.xml. Specifies the settings for the app's
administrators. For details, see the administrator settings section in "How
do I define the configuration for my app?" on page 16.

<app_name>-ds-provider.xml. Specifies the data source settings that
enable the app to communicate with the backend server. For details, see
the data source settings section in "How do I define the configuration for
my app?" on page 16.

<app_name>-user-settings.xml. Specifies the settings for the app's
users. For details, see the user settings section in "How do I define the
configuration for my app?" on page 16.

Referenced
Libraries

Third-party libraries that are available for the app (project dependencies).

JRE System
Library

The JRE libraries that are available for the app.

src The JavaScript client code, which is divided into folders per form factor.
The common folders contain JavaScript code that is used by all defined
form factors.
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src\webapp The client-side resources and settings for the app.

app. The JavaScript client code for the app.

css. The Cascading Style Sheet that defines the look and formatting of the
app's graphical user interface. The common folder includes the default
fonts and CSS for all form factors. You can add or modify style-sheet code
for all form factors, as needed.Tomodify a specific form factor, expand the
desktop, smartphone, or tablet folder and add form-factor-specific style-
sheet code, as needed.

images. The referenced images used by your app.

Each of the app, css, and images folders contains the following
subfolders:

l common. Content that applies to all form factors.

l desktop. Content that applies only to the desktop app.

l tablet. Content that applies only to the tablet app.

l smartphone. Content that applies only to the smartphone app.

The descriptor.xml file (described above)

WEB-INF. The directory for the J2EE container, which contains the
standard web.xml file and resources for spring, log4j, and third-party
logging.

app.js. Contains the JavaScript code for your app, including the
openEntryPoint function that specifies the client location that opens when a
user opens your app. For details, see the HP Anywhere API specifications.

target The target files that are created when your app runs. This folder is empty
when your app project is created.

When the app is ready for release, you can give the <App
project>\target\<App name>-cp.zip file to your HP Anywhere
administrator for deployment to the catalog.

minify.bat A batch file that HP Anywhere IDE uses tominify the app.

package.js Contains app information that is relevant for theminification process.

pom.xml Contains general app data, such as the app name, version,and description.

pom-
project.properties

Contains general app data, such as the template type, port, hostname, and
user credentials.
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Appendix 2: Template Descriptions
HP Anywhere IDE provides starter projects that you can use as a basis for your own app projects.
All of the project templates include the required project folder structure. TheMy Report projects
also include code so that you can use to create an app that communicates with a REST API and
generates a list of reports.

Template Description

Blank Project AnHP Anywhere starter project that contains the project folder structure
without application content.

Hello World AnHP Anywhere starter project that generates an app using the native
framework with JavaScript and HTML code.

Hello World (Enyo) AnHP Anywhere starter project that generates an app using the Enyo
framework. This project is targeted for use on tablets and smartphones.

Hello World (Jqm) AnHP Anywhere starter project that generates an app using the jQuery
Mobile framework. This project is targeted for use on tablets and
smartphones.

Hello World
(Sencha)

AnHP Anywhere starter project that generates an app using the Sencha
Touch framework. This project is targeted for use on tablets and
smartphones.

Hello World
(AngularJS)

AnHP Anywhere starter project that generates an app using the
AngularJS framework. This project is targeted for use on tablets and
smartphones.

My Report AnHP Anywhere starter project that uses the native framework with
JavaScript and HTML code to generate an app that can display a list of
reports.

My Report (Enyo) AnHP Anywhere starter project that uses the Enyo framework to
generate an app that can display a list of reports. This project is targeted
for use on tablets and smartphones.

My Report (Jqm) AnHP Anywhere starter project that uses the jQuery Mobile framework
to generate an app that can display a list of reports. This project is
targeted for use on tablets and smartphones.

My Report (Sencha) AnHP Anywhere starter project that uses the Sencha Touch framework
to generate an app that can display a list of reports. This project is
targeted for use on tablets and smartphones.

My Report
(AngularJS)

AnHP Anywhere starter project that uses the AngularJS framework to
generate an app that can display a list of reports. This project is targeted
for use on tablets and smartphones.
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Blank Project Template
AnHP Anywhere starter project that contains the standard app folders and files, but does not
contain any app-specific content. For folder and file details, see "Appendix 1: App Project Folder
Structure" on page 39.

Templates for Native Apps
Hello World is a native HTML 5 app that displays the HP Anywhere icon in the HP AnywhereMy
Apps page. In addition to the standard folders and files described in "Appendix 1: App Project Folder
Structure" on page 39, this project includes:

l src\webapp\app\common: This folder contains the client-side JavaScript, CCS, and image
files. The code is stored in the common folder, making it available for all form factors.

l src\webapp\app\common\views: This folder contains:
n content.html: The HTML template for this app.

n MainView.js: The initial view that loads the content of the JavaScript and HTML files.

n summary.html: The content displayed in the HelloWorld app card on theMy Apps page for
the desktop form factor. For example, a card usually contains the app name, an icon, and
optional content, such as a textual description or summary, a list of items, or a dashboard.

My Report is a native HTML 5 app that displays a report list. In addition to the standard folders and
files described in "Appendix 1: App Project Folder Structure" on page 39, this project includes:

l src\webapp\app\common: This folder contains the client-side JavaScript, CCS, and image
files for the report. The code is stored in the common folder, making it available for all form
factors.

l src\webapp\app\common\views: This folder contains:
n content.html: The HTML template for this app.

n Content.js: Used to retrieve the data from the server for the report.

n MainView.js: The initial view that loads the content of the JavaScript and HTML files.

n summary.html: The content displayed in theMy Report Project app card on theMy Apps
page for the desktop form factor. For example, a card usually contains the app name, an icon,
and optional content, such as a textual description or summary, a list of items, or a
dashboard.
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Templates for Enyo-based Apps
Each template is designed to conform to the standard app structure of an Enyo-based app. HP
Anywhere IDE uses the Enyo loader to initialize the view and render the output to the display.

Hello World (Enyo) is an Enyo-based app that displays the HP Anywhere icon in the HP
AnywhereMy Apps page. In addition to the standard folders and files described in "Appendix 1: App
Project Folder Structure" on page 39, this project includes:

src\webapp\app.js: Initializes the HelloWorld view and renders the output to the display. This is
the controller that contains the logic behind the app.

My Report (Enyo) .is an Enyo-based app that displays a report list. In addition to the standard
folders and files described in "Appendix 1: App Project Folder Structure" on page 39, this project
includes:

l src\java\com\hp\<project_name>\...\rest: This folder contains the following REST service
classes for retrieving the report list:
n ReportBean.java class: The report entity.

n ReportService.java class: The REST implementation, which contains embedded, mock
data.

l src\webapp\app\common: This folder contains the Enyo resources needed for the client side
of the report app, including:
n enyo: The Enyo library code.

n report: The Report.js and ReportItem.js classes, which define how the report list is
displayed.

l src\webapp\css\common: This folder contains the Enyo-specific app styles for the report.

l src\webapp\app.js: Initializes the report view and renders the output to the display.

Templates for Sencha Touch-based Apps
The structure of each template is designed to conform to the best practices for creating a Sencha
Touch-based app, including theModel View Control.

Hello World (Sencha) is a Sencha Touch-based app that displays the HP Anywhere icon in the
HP AnywhereMy Apps page. In addition to the standard folders and files described in "Appendix 1:
App Project Folder Structure" on page 39, this project includes:

l src\webapp\app\common: This folder contains the Sencha Touch resources needed for the
client side of the app, including controller, data, mode, store, and view folders. These resources
are stored in the common folder, making them available for all form factors.
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My Report (Sencha) .is a Sencha Touch-based app that displays a report list. In addition to the
standard folders and files described in "Appendix 1: App Project Folder Structure" on page 39, this
project includes:

l src\java\com\hp\<project_name>\...\rest: This folder contains the following REST service
classes for retrieving the report list:
n ReportBean.java class: The report entity.

n ReportService.java class: The REST implementation, which contains embeddedmock
data.

l src\webapp\app\common: This folder contains the Sencha Touch resources needed for the
client side of the report app, including controller, data, mode, store, and view folders. These
resources are stored in the common folder, making them available for all form factors.

Templates for jQuery Mobile-based Apps
Hello World (JQM) is a jQuery Mobile-based app that displays the HP Anywhere icon in the HP
AnywhereMy Apps page. In addition to the standard folders and files described in "Appendix 1: App
Project Folder Structure" on page 39, this project includes:

l src\webapp\app\common: This folder contains the JQM resources needed for the client side of
the app, including conf, controller,and view folders. These resources are stored in the common
folder, making them available for all form factors.

l src\webapp\libs\jqmobile: This folder contains the JQM images, CSS, and functions for the
app.

l src\webapp\libs\jquery: This folder contains the jQuery files for the app.

l src\webapp\libs\requirejs: This folder contains the resources needed to load the app.

My Report (JQM) .is a jQuery Mobile-based app that displays a report list. In addition to the
standard folders and files described in "Appendix 1: App Project Folder Structure" on page 39, this
project includes:

l src\webapp\app\common: This folder contains the JQM resources needed for the client side of
the app, including conf, controller, models ,and view folders. These resources are stored in the
common folder, making them available for all form factors.

l src\webapp\libs\jqmobile: This folder contains the JQM images, CSS, and functions for the
app.
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l src\webapp\libs\jquery: This folder contains the jQuery files for the app.

l src\webapp\libs\requirejs: This folder contains the resources needed to load the app.

Templates for AngularJS-based Apps
The structure of each template is designed to conform to the best practices for creating an
AngularJS-based app. The structure includes only the standard folders and files described in
"Appendix 1: App Project Folder Structure" on page 39. There are no unique files or folders.
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Appendix 3: Troubleshooting
This section describes how to handle issues that youmay encounter:

How do I set up a Maven proxy?
If you connect to the Internet via a proxy, youmay need to configure aMaven proxy to connect to
theMaven repository. If you try to create an app project without first setting the required proxy, the
following error message is displayed:

To configure a Maven proxy:

Update the <proxies> section in%btoa_home%/apache-maven-3.0.4/conf/settings.xml and
add a proxy.
For example:

<proxy>

    <id>MYNETPROXY</id>

    <active>true</active>

    <protocol>http</protocol>

    <host>myproxyhost.mydomain.com</host>

    <port>8080</port>

    <nonProxyHosts>*.devlab.ad</nonProxyHosts>

</proxy>

How do I update HP Anywhere IDE with the latest
HP Anywhere Plugin

The HP Anywhere Plugin is updated regularly. You can download and install the latest HP
Anywhere Plugin at your convenience. You can also configure HP Anywhere IDE to automatically
receive and download updates to the HP Anywhere Plugin.
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To manually install the latest HP Anywhere Plugin and receive automatic update
notifications in the future:

1. In HP Anywhere IDE, select Help > Install New Software. The Available Software wizard
opens.

2. In theWork with field, select HP Anywhere Eclipse Update Site. The text area in the center
of the wizard screen dynamically displays HP-related check boxes.

3. Select theHP check box.

4. Click Next and follow the wizard's instructions.

5. When prompted, restart HP Anywhere IDE.

This process installs the latest version of the plugin and configures HP Anywhere IDE to
automatically notify you when future updates become available.

To receive/configure automatic notifications when a new plugin update is available:

1. SelectWindow > Preferences > Install/Update > Automatic Updates.

2. In the Automatic Updates pane, select theAutomatically find new updates and notify me
check box.

3. Configure the schedule and download options for receiving notifications when updates to the
plugin are available.

4. Click OK.

From now on, when updates to the plugin are released, you will receive notifications, enabling
you to install the latest version of the plugin at your convenience.

To disable automatic notifications when a new plugin update is a available:

1. SelectWindow > Preferences > Install/Update > Automatic Updates.

2. In the Automatic Updates pane, clear theAutomatically find new updates and notify me
check box.

3. Click OK.

You will no longer be notified when new updates are available.

HP Anywhere IDE (10.10)Page 48 of 51

Developer Guide (Eclipse)
Appendix 3: Troubleshooting



How do I run an app that was created using an
earlier version of HP Anywhere IDE?

After you upgrade HP Anywhere IDE, your appmay not run seamlessly on the newer version
because it was not compiled against the latest HP Anywhere server version:

To upgrade your app to the current version:

1. In the HP Anywhere IDE Package Explorer, navigate to: <app main node>/pom.xml and
double-click the file to open it.

2. In the Design or Source tab, modify the btoa.build.version value to the latest version, for
example: 10.10.100

3. Run the app to recompile it.

What should I do if the getUserName method
(UserInfoService API) returns NULL?

1. In the Package Explorer, navigate to: <app main node>/src/webapp/WEB-INF/Web.xml
and double-click the file to open it.

2. Replace the <filter> section with the following:

<filter>
<filter-name>DiamondTenantFilter</filter-name>
<filter-class>org.springframework.web.filter.DelegatingFilterProxy

</filter-class>
</filter>
<filter-mapping>

<filter-name>DiamondTenantFilter</filter-name>
<url-pattern>/rest/*</url-pattern>
<url-pattern>/services/*</url-pattern>

</filter-mapping>

<filter>
<filter-name>springSecurityFilterChain</filter-name>
<filter-class>org.springframework.web.filter.DelegatingFilterProxy

</filter-class>
</filter>
<filter-mapping>

<filter-name>springSecurityFilterChain</filter-name>
<url-pattern>/*</url-pattern>

</filter-mapping>
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<filter>
<filter-name>DiamondSecurityFilter</filter-name>
<filter-class>org.springframework.web.filter.DelegatingFilterProxy

</filter-class>
</filter>
<filter-mapping>

<filter-name>DiamondSecurityFilter</filter-name>
<url-pattern>/rest/*</url-pattern>
<url-pattern>/services/*</url-pattern>

</filter-mapping>
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